Decision Making Using Excel 2013

LEARNING OUTCOMES

1. Describe the use of the IF function.
2. Compare the functions of Goal Seek and Solver.
3. List the advantages of using the Scenario Manager.

Introduction

Most of the decision-analysis tools on the market focus on one specific analyti-
cal technique, like simulation or decision trees. They may be tailored to a specific
industry need, such as insurance claims modeling. Furthermore, the cost of these
tools can run into the tens of thousands, even millions, of dollars—such as SAS and
Cognos. One integrated set of tools that combines the best analytical methods, can
be applied to different problems, and is reasonably priced is Microsoft Excel 2013.

The measure of any business intelligence solution is its ability to derive knowl-
edge from data, as discussed in the core units of this book. This plug-in will exam-
ine a few of the advanced business-analysis tools that have the capability to identify
patterns, trends, and rules and create “what-if” analyses. There are four areas in
this plug-in:

1. The IF function is used to conduct conditional tests on values and formulas.

2. The Goal Seek function is used to find an unknown value that produces a desired
result.

3. The Solver function is used to calculate an optimum solution based on several
variables and constraints.

4. The Scenario Manager function is used to create and evaluate a collection of
“what-if” scenarios containing multiple input values.

Creating Formulas Using the IF Function

The IF logical function will return one value if a condition is TRUE and another
value if the condition is FALSE. Use the IF function when you want to compare two
items in your workbook. The IF function looks like this:

=IF(logical_test,value_if_true,value_if false)
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m Logical_test is any value or expression that can be evaluated to 7 N
_ . . . Logical operators are used to compare
TRUE or FALSE. For example, A10 = 100 is a logical expression; :
. . . . numbers in two or more cells to a constant.
if the value in cell A10 is equal to 100, the expression evaluates to
TRUE. Otherwise, the expression evaluates to FALSE. This argu- = Equal to
ment can use any comparison calculation operator. _ Less than
m Value_if true is the value that is returned if the logical_test is
TRUE. For example, if this argument is the text string “Within | ~ Greater than
budget” and the logical_test argument evaluates to TRUE, then = Less than or equal to
the IF function displays the text “Within budget.” Note: Value_if
true can be another formula. - Greater than or equal to
m Value_if false is the value that is returned if the logical test is | 7 Not equal to
FALSE. For example, if this argument is the text string “Over bud- | \o71 Logical Not
get” and the logical_test argument evaluates to FALSE, then the .
IF function displays the text “Over budget.” Note: Value_if _false | AND Logical And
can be another formula. \ OR Logical Or )
To use the IF function follow these steps:
FIGURE

. Select the cell in which you want to enter the function. Logical Operators

. Click the Formulas tab, then click the Insert Function button.
. Click IF from the list of Logical functions and click OK.

. In the Function Arguments dialog box that opens, enter the Logical_test argu-
ment. This argument states the condition you want to test for. Use cell refer-
ences and/or values with logical operators. Figure T4.1 displays the list of logical
operators.

B2 W N -

5. Enter the Value_if true argument. This is the text string or value that will be dis-
played if the logical_test argument is true.

6. Enter the Value_if false argument. This is the text string or value that will be
displayed if the logical_test argument is false.

1. Click OK.

For example, in a loan analysis worksheet, you want to write a conditional
expression that examines the ratio of a loan amount to a purchase price. The logic
for solving this is if the ratio is greater than 0.8, then there is an assessment fee of
$300. Otherwise, the assessment fee is $0.

To create a conditional expression, complete the following steps:

1. Open the workbook T4_LoanAnalysis_Data.xls that accompanies this textbook.

2. Click cell B14, the cell that will display Assessment if the ratio of loan amount to
purchase price is greater than 0.8—the same criteria for displaying (or not) an
assessment fee of $300.

3. Type =IF(B13/B4 > 0.8,300,0) and press Enter. The cell displays 300 because
the loan-to-price ratio is 0.875.

When you are unsure of a function and want help writing it, you can use the
Insert Function command. Executing the Insert Function command opens a dialog
box that lists functions by categories and helps you build the function.

To write an IF function using the Insert Function complete the following steps:

1. Click cell B16 to make it active.

2. Click the Formulas tab, then click the Logical button and select IF. The Function
Arguments dialog box opens (see Figure T4.2).

3. Click the Logical_test box and type B13/B4 > 0.8 (there are no spaces in this
line). Notice that the moment you type 0.8, the label TRUE appears to the right of
the value. That indicates the current value of the expression based on the condi-
tion you just completed.

Plug-In T4 Decision Making Using Excel 2013
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Formula result =

Help on this function

Checks whether a condition is met, and retums one value if TRUE, and another value if FALSE,

Logical_test is any value or expression that can be evaluated to TRUE or FALSE.

Function Arguments
IF
Logical test || BE| = logica 4. Click the Value-if-true box and type 300, which is
e e Bl = any the value to return if the condition is true.
Value_ff false | = any 5. Click the Value-if-false box and type 0, which is

the value to return if the condition is false (see
Figure T4.3).

6. Click OK to complete the function. Excel places the
completed IF function into cell B16, calculates the
value of the function, and displays 300.00 because
the ratio of the down payment to the purchase price

is greater than 0.8.
Cancel

FIGURE

Function Arguments
Dialog Box

Goal Seek

Goal Seek is an analytical function that allows a value in a formula to be adjusted to
reach a desired result or answer. Goal Seek can eliminate unnecessary calculations
that can be used to determine a single variable value in a formula. For example, a
salesperson might participate in a bonus program that pays 3 percent of all sales
dollars. The salesperson wants to receive a bonus of at least $2,500 and needs to
know the target sales dollar amount needed.

Create a worksheet with the following information (see Figure T4.4 for a layout
design):

FIGURE

Function Arguments

Dialog Box

rLahel Cell Address  Value \
Sales Dollars B1 (unknown—Ieave blank)
Bonus Percentage B2 3%

@onus Amount B3 =B1*B2 Y,

When the Goal Seek command starts to run, it repeatedly tries new values in the
variable cell to find a solution to the problem. This process is called iteration, and it
continues until Excel has run the problem 100 times or has found an answer within
.001 of the target value specified. The iteration settings can be adjusted by clicking
the Office button, then clicking Excel Options, clicking the Formulas button, and
adjusting the Maximum Iteration options. It calculates so fast, the Goal Seek com-
mand can save significant time and effort over the brute force method of trying one
number after another in a formula.

USING THE GOAL SEEK COMMAND

3 - |

Function Arguments . .
. The Goal Seek fegtgre is used to fill in the target value
ropentest [somies S of the cell containing ‘:[he Sales Dollars amount. The
o if‘true = Erl{l: o Goal Seel‘( values read Sf:t cell = B3, To value = 2500,
S : E{; L By changing cell = $B$1.
o = To use the Goal Seek command:
= 300

Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE,

Value_if_false is the value that is returned if Logical_test is FALSE. If omitted, FALSE
is returned.

Formula result = 300

Help on this function

1. Click the Data tab. In the Data Tools group click
What-If Analysis and then click Goal Seek.

2. In the Goal Seek dialog box, specify the cell that
contains the desired value in the Set cell: box. Type
in or select B3.

Cancel
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FIGURE

- goal seek - Exc
HOME  INSERT ~ PAGELAYOUT ~ FORMULAS ~ DATA = REVIEW  VIEW  ADD-INS  ACROBAT
- Goal Seek Worksheet
Connections Clear
Properties Reapply
m  From From Other Existing Refresh X Sort Filter _ Textto Flash Remove Data  Consolidate W
Web Tet Sources- ' Connections | Al Edit Links Advanced | Columns Fill - Duplicates Validation
Get Bxternal Data ! Connections Sort & Filter Data Tools

Leave blank. Bl M £ | -Br'm2
This is what —d A B C D | E | F G H
Goal Seek will 1 Sales Dollars L .l
solve. 2 Bonus Percentage 3% Goal Seek ?

4 To value: 254_)0
Enter formula = By changing cell: |Ses1 =
for Goal Seek 5 Concel
to solve. .

1

8

9

10

1

12

13

3. Enter the desired value or answer in the To value: box. Type in 2500.
4. Enter the cell whose value will be changed in the By changing cell: box. Type in

or select $B$1.

5. The Goal Seek dialog box should look like Figure T4.5.

6. Choose OK.

a. Ifasolution is found, the Goal Seek Status dialog box appears.

b. The results are shown in Figure T4.6.
1. Select OK.

Goal Seek is used to adjust a single variable in a formula. Use the Solver feature
to adjust multiple variables in a formula, as described in the next section.

EEE R e

goal seek - Excel

HOME INSERT PAGE LAYOUT FORMULAS DATA | REVIEW VIEW ADD-INS ACROBAT FIG URE
Connections Clear Goal Seek Function
n'l Properties Reapply
From From From From Other Existing Refresh Sort Filter . Textto Flash Remove Data  Consolidate What-If Relationships
Access Web Text Sources Connections | All Edit Links Advanced | Columns  Fill  Duplicates Validation Analysis
Get External Data Connedtions _ Sort & Filter Data Tools
Bl M K < | =B1*B2
A B c | D E F G | H | 1

T T

| |
1 |Sales Dollars b ol

?
2 Bonus Percentage 3% Goal Seek ‘
3 |Bonus Amount S - Set cell: [ =
'

4 To value: 2500
5 = By changing cell: | $B51 'x
4
8
9
10
11
12
12
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oy = goal set
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ACROBAT

Connections Clear

FIGURE Properties

Fr From From From Other Existing Refresh _I ) Sort Filter Textto Flash Remove Data Consolidate Wh
Goal Seek Results Acc A Text Sources Connections All Edit Links Columns  Fill  Duplicates Validation Anal

Get External Data Connections Sort & Filter Data Tools
B3 M b =B1*B2
A B C D E F G H
1 Sales Dollars S  83,333.33
?
2 Bonus Percentage 3% EEall s EE
3 Bonus Amount S 2 500 00 Goal Seeking with Cell B3
| ! & .| found a solution,

4 Target value: 2500

= = Current value:  $2,500.00

6 I Cancel

7

8

g

Solver

Solver is part of a suite of functions sometimes called what-if analysis tools used for
optimizing problems that contain more than one variable. The Solver add-in utility
is needed to analyze the scenarios in decision-making situations that involve con-
sideration of values and constraints for several variables simultaneously. This pow-
erful function uses multiple changing variables and constraints to find the optimal
solution to solve a problem.

For example, consider a coffee shop that currently sells three beverages: (1) regu-
lar fresh-brewed coffee, (2) premium caffe latte, and (3) premium caffe mocha. The
current price for regular coffee is set at $1.25, caffe latte at $2.00, and caffe mocha at
$2.25, but the revenue potential is uncertain. What special emphasis (or marketing)
should be given to each of the beverages to maximize revenue? Although the pre-
mium coffees bring in more money, their ingredients are more expensive and they
take more time to make than regular coffee. Making some basic calculations by
hand is easy, but there needs to be some structure to the sales data in a worksheet
so that periodic changes can be made and analyzed.

INSTALLING SOLVER

Solver comes with the standard Excel package, but it has to be installed. To install
Solver, do the following:

1. Click the File tab, and then click Options.

2. Click Add-Ins, and then, in the Manage box, select Excel Add-ins. Click Go.

3. In the Add-Ins Available box, select the Solver Add-in check box, and then click
OK.

4. After you load the Solver Add-in, the Solver command is available from the
DataTab.

SETTING UP THE PROBLEM

The first step in using the Solver command is to build a “Solver-friendly” worksheet.
This involves creating a target cell to be the goal of your problem—for example,
a formula that calculates total revenue—and assigning one or more variable cells
that the Solver can change to reach the goal.
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Leave blank.
This is what —

The Total Revenue
is the sum of D6,
D10, and D14.

J| =DB+D10+D14 i

A B G D E I G/ H il K

Total Revenuel $ - !

Pony Expresso

1
i
3
4 Price per reqular coffee:| § 1.25
5
6

ups needed to 58

FIGURE

Coffee Sales Data Sheet
for Solver

The Regular
cups value
comes from D5.

Cups needed to sell
ubtotal: - Regular cups -
7 Premium cups - R
Price per premium latte: § 2.00 Total cups T T The Pl’emlum

Solver W[I/ 10 Subtotal: § Constraints _ Cups Va/ue
11 Max cups 500
12 Price per premium mocha: § 2.25 Max premium 350

SUIVB. 13 Cups needed to sell Max mocha 125 comes frUm
14 Subtotal: & =
= D9+ D13.

To use Solver, complete the following:

. Set up a worksheet similar to Figure T4.7 (this will follow the scenario presented

above).

. The three variable cells in the worksheet are cells D5, D9, and D13. These are the

cells whose values Solver needs to determine to maximize the weekly revenue.

. In the bottom-right corner of the table is a list of constraints to use for

forecasting.

. The worksheet must contain cells (G6 through G8) that include the formulas

used as constraints. The limiting values for the constraints are listed in cells G11
through G13:

m No more than 500 total cups of coffee (both regular and premium).

m No more than 350 cups of premium coffee (both caffe latte and caffe mocha).
m No more than 125 caffe mochas.

. The subtotals for cells D6, D10, D14 need to be calculated, as well as the Total

Revenue (sum of D6, D10, and D14) in G4.

. The value for cell G6 should equal the value that will be calculated for D5, and

the value for cell G7 will be the sum of the values
from D9 and D13. The calculation of G8 equals the
sum of D5, D9, and D13.

Click the target cell G4—the one containing the for-
mula that is based on the variable cells you want
Solver to determine.

Click on the Data tab and then click the Solver
button. The Solver Parameters dialog box opens, as
shown in Figure T4.8 . Select the Set Target Cell:

Set Objective: spss
To: () Max (®){hiin,

By Changing Variable Cells:

Subject to the Constraints:

Solver Parameters

FIGURE

Solver Parameters Dialog
Box

() Walue OF:

box (unless it already contains the correct
reference),

Add

Change

Delete

Reset All

Load/Save

Select a Solving Method:

Salving Method

Simplex engine for linear Solver Problem:

problems that are non-smooth.

Plug-In T4

Make Unconstrained Variables Non-Negative

GRG Manlinear

el Options

Select the GRG Nonlinear engine for Solver Problems that are smooth nonlinear. Select the LP
ve: s, and select the Evolutionary engine for Solver
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Set Objective: 5G4
To: [CHYF

By Changing Variable Cells:
5D55,5D59,5D513

Subject to the Constraints:

Solver Parameters

O Value OF:

and then click cell G4 to insert $G$4 as the target

— cell. The Equal To: option button, Max, is already

- selected. Do not change this since the problem
- requests the maximum value for the target cell.

e 9. Select the By Changing Cells: box. Click the

Make Unconstrained Variables Non-Negative

Sglect a Solving Method: GRG Monlinear

Solving Method

problems that are non-smooth.

Help

FIGURE
By Changing Cells Values

in Solver Parameters

Dialog Box
1.
12.
13.

FIGURE

Solver Parameters with
Constraints

Select the GRG Nonlinear engine for Solver Problems that are smooth nonlinear. Select the LP
Simplex engine for linear Solver Prablems, and select the Evolutionary engine for Solver

Solve

Collapse Dialog button to the right of the box to
collapse the dialog box. Select each of the variable
cells by holding down the CTRL key and clicking
D5, D9, and D13. This places commas between the
three cell entries in the box: $D$5, $D$9, $D$13
(refer to Figure T4.9).

10. This problem has three constraints. Click Add, in

b Options

the Subject to the Constraints: section, to add the first constraint in the Add
Constraint dialog box.

The first constraint is the coffee shop can sell only 500 cups of coffee in one
week. To enter this constraint, after clicking in the Cell Reference: box, click
cell G8, click <= in the operator drop-down list, and with the insertion point
in the Constraint: box, type or click cell G11.

. Click Add to enter the first constraint and begin the second constraint—the

coffee shop can sell only 350 premium coffees in one week. With the inser-
tion point in the Cell Reference: box, click cell G7, click <= in the operator
drop-down list, and in the Constraint: box, type or click cell G12.

. Click Add to enter the second constraint and begin the third—the coffee shop

can sell only 125 caffe mochas in one week. Click cell D13, click <= in the
operator drop-down list, and in the Constraint: box, type or click cell G13.

. Click OK to add all three constraints to the Solver Parameters dialog box as

shown in Figure T4.10.

Click Solve to calculate the result.

Solver displays a dialog box describing the results of the analysis. If Solver runs
into a problem, an error message will be displayed. If Solver finds a solution, a
Solver Results dialog box will appear.

To display the new solution in the worksheet, click the Keep Solver Solution
option button in the Solver Results dialog box, and then click OK. Solver places
an optimum value in the target cell and fills the variable cells with the solutions
that satisfy the constraints specified and provide the optimal result, as shown in
FigureT4.11.

EDITING A SOLVER FORECAST

The Solver tool is very useful in modifying the constraints to evaluate new goals and

Set Objective:
To: (@) Max ) Min ) Value Of:

By Changing Variable Cells:
5DS$5,5D59,5D513

Subject to the Constraints:

Solver Parameters

possibilities. For example, if a coffee shop wants to earn
exactly $800 per week from coffee drinks, use Solver to
“solve” for the optimum combination of drinks. Setting
a target value in Solver is alittle like using the Goal Seek
-~ command to determine a value for an unknown vari-

5DS13 <= 5G513
SGS7 <= SGS12
5G38 <= 5G311

able, although Solver can use more than one variable.
To edit the Solver forecast to find the variables to reach
a specific goal, follow these steps:

Add
Change

Delete

Reset All

1. Select the Data tab then select Solver. The

Load/Save

Make Unconstrained Variables Non-Hegative

Select a Solving Method: GRG Monlinear

Solving Method
Select the GRG Nonlinear en.

problems that are non-smooth

Help

T4-7 Plug-In T4

gine for Solver Problems that are smo
Simplex engine for linear Solver Problems, and select the Evolutionary engine for Solver
th.

Solve

Solver Parameters dialog box appears, still dis-
playing the variables and constraints of the last

b Options

oth nonlinear. Select the LP

Close



FIGURE
Optimum Revenue for
Solver Results

| G4 - Jfx| =D6+D10+D14
A B £ D E F
1
2
Given the 4| Price per regular coffee: § 125 Total Revenuel § 018.75 _l
constraints, 5 Cups needed to sell 150
Sol /BT/ Subtotal: § 187.50 Regular cups 150
olver < Premium cups 350
determined the NCE per premium latte: §  2.00 Total cups 500
9 Cups needed to sell 225
cups needed to P
p 10 Subtotal: § 450.00 Constraints
sell. 11 Max cups 500
12 ice per premium mocha: §  2.25 Max premium 350
13 Cups needed to sell 125 Max mocha 125
14 Subtotal: § 281.25
15

Solver problem. These will be adjusted to compute a new forecasting goal.

2. Click the Value of: option button and type 800 in the box to the right. The
Value of: option button sets the target cell to a particular goal to determine the
vari-able mix needed to reach the milestone. The dialog box should look
similar to Figure T4.12.

3. Click Solve to find a solution to the problem. When Solver has finished,
click OK to display the new solution.

Figure T4.13 shows the new solution that Solver generates.

Note: The results presented in Figure T4.13 are one possible solution that Solver may return.

Scenario Manager

A scenario is a set of input values and corresponding results from calculations that
Excel can save and report as needed. A worksheet can be used to conduct a “what-
if” analysis on a particular set of data. Several input values in a worksheet might
change depending on different situations or circumstances. Values that produce
different results can be stored as scenarios.

Excel’s Scenario Manager allows 32 different scenarios or groups of values to be
defined. The Scenario Manager can then be used to selectively display the desired
values or scenario in the worksheet. The Scenario Manager eliminates the need
to have multiple copies of the same worksheet representing different situations.
For each group of input values a scenario must be named and stored before it can
be used.

Plug-In T4
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FIGURE

Set Objective: 5G54
To: (@) Max ) Min

By Changing Variable Cells:
$DS5,5D89,5D513

Subject ta the Constraints:

FIGURE

Solver Parameters

) Value OF:

Editing Solver Forecast

SDS13 «= 56513
SGS7 == 5GS12
§GS8 «= 5GS11

aaa SETTING UP SCENARIOS

Change

Each group of input values or scenarios must be named
and stored before it can be used. Scenarios are stored
with the worksheet. To set up a scenario:

Delete

Reset All

Load/Save

Make Unconstrained Variables Non-Negative

select a Solving Method:

Solving Method

Select the GRG Nonlinear engine for Solver Problems that are smooth nonlinear, Select the LP 2
Simplex engine for linear Solver Problems, and select the Evolutionary engine for Solver

problems that are non-smooth.

Help

Solver Solution

GRG Nonlinear

1. Open the file T4_Scenario_Data.xls that accompa-
nies this text (see Figure T4.14).

Click on the Data tab, click the What-If Analysis
button, and then select Scenario Manager.

Click Add to display the Add Scenario dialog box.
4. Enter Original in the Scenario name: box.

Options

. In the Changing cells: box, type D9:D11 or use the Collapse Dialog button at

the right side of the box to manually select the cells that hold the Number of
Technicians, Regular Hours, and OverTime Hours values.

. Choose OK. The Scenario Values dialog box appears.

1. The Scenario Values dialog box will display the values for cells D9, D10,

10.

1.

and Dllas 1,300, and 0, respectively, as shown in Figure T4.15 . Click OK.
You will return to the Scenario Manager dialog box.

Once the original values have been saved, the what-if scenarios need to be
created.
Click Add. In the Add Scenario dialog box, type Single Contractor Overtime.

Click OK. In the Scenario Values dialog box for cell D11, enter 40. The values in
cells D9 and D10 remain at 1 and 300, respectively.

Click OK. Ensure that the Single Contractor Overtime scenario is selected, and
click Show. Excel reports that this project will need an additional $3,000,
as shown in Figure T4.16.

| 54 - Jfx| =D6+D10+D14
A & D E B G H
1
o 2 Pony Expresso
Modifying the 3
constraints, 4 Price per regular coffee: § 1.25 Total Revenuel $  800.00 _l
5 Cups needed to sell 123
Solver ——E"’"’/ Subtotal: 5 15357 Regular cups 123
adjusted the %\ Premium cups 309
Price per premium latte: § 2.00 Total cups 432
cups needed to g Cups needed to sell- 197 85714
sell. 10 Subtotal: § 39571 Constraints
11 Max cups 500
12 ige per premium mocha: § 225 Max premium 350
13 Cups needed to sell: 111.42857 Wax mocha 12570
14 Subtotal: § 250.71
15
1R
T4-9 Plug-In T4



The Total Cost
is what Scenario
Manager will
optimize, given
some values
will change.

—

HOME \NVSERT
s[5 [

From From From FromOther | Exsting | Refresh

H -
PAGE LAYOUT

Access Web Text Sources- ' Connections | All~

E3

0O ~NO A WN =

Get External Data

d F

& |3

FORMULAS | DATA | REVIEW  VIEW  ADD-INS

[ Connections | | [FTR Clear
comsie | oy ) | 7
roperties

z
Edit Links il

Connedtions

ACROBAT

Y
L=
Textto Flash

Vo Advanced | Columns il ©
Sort & Filter

Reapply
Sort | Filter

A B c D E E G
Project
Project Start Date: 01/01/20 I
Est. Duration (hours): 300
Completion Date: 08/01/20 FIGURE
Total Cost: $ 15,000.00 X
Scenario Data Template
Number of Technicans: 1
Regular Hours: 300 Example
OverTime Hours: 0
Contractor Surcharge: $ 200.00
Standard Per-Hour Rate: $ 50.00
Over Time Rate: $ 75.00
Regular Cost: $ 15,000.00
Over Time Cost: $ -
Total Hours Worked: 300

12. Create one more scenario. In the Scenario Manager dialog box, click Add

again.

13. The Add Scenario dialog box appears. In the Scenario name: box, type Two
Contractors No Overtime.

14. The Changing cells: (D9:D11) should already appear in the proper boxes; if not,
enter that range. Click OK to invoke the Scenario Values dialog box.

15. Two outside contractors are brought in (by charging $200 for each additional
technician). Enter 2 in the box for cell D9 and 0 in the box for cell D11. In cell
D10’s box, type
two technicians to split the time. Click OK.

16. Click OK to dismiss the message, and Excel returns

= 300/2 since there will be

you to the Scenario Manager dialog box.

17. Select Two Contractors No Overtime and click
Show. Excel displays 150 in cell D10 even though
the total hours are 300. This scenario gives a com-

pletion cost of $15,200.

Compare the Scenarios

» Il

Scenario Values

Enter values for each of the changing cells.

1 DS |1
Z $DS10 |300
3 sDS11 [0

Cancel

FIGURE
Scenario Values Dialog
Box Values

Compare each scenario to determine the best solution, such as:

Gcenario Cost\
Original $15,000
Single Contractor Overtime $18,000

Qwo Contractors No Overtime $15,200)
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FIGURE

Single Contractor
Overtime Scenario
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HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS ACROBAT

Connections

E

Properties
From From From From Other Existing Refresh sl Sort Filter R - Textto Flash Remove Data
Sr RS YEay Sy IM@rrmediened | Edit Links Advanced | Columns  Fill Duplicates Validation
Get External Data Connections Sort & Filter Datal
D7 M fe | =(D9%(D10°D13))+{D9*(D11*D14))+(D12*(D9-1)}
A B c D E F G H 1 J K L
4
z Project
3
4 Project Start Date: 01/01/20 N .
5 Est. Duration (hours) 300 Scenario Manager » Il
6 Completion Date: 08/01/20 -
7 Total Cost:[ §_18,000.00 =
8 + Add...
9 Mumber of Technicans 1 e
10 Regular Hours 300
11 OverTime Hours 40 Edt..
12 Contractor Surcharge: §  200.00
13 Standard Per-Hour Rate: § 50.00 n
14 Over Time Rate: § 75.00 =
15 Regular Cost: §  15,000.00 summary...
16 Over Time Cost: 5 3,000.00
17 Total Hours Worked: 340
15’ Changing cells: | SD59:5D511
19 Comment: Created by amyphill on 3/26/2004
20
21
2
23
2 B
25
2
27
28
29
30

Click Show to see the
different scenario.

MODIFYING A SCENARIO
Once scenarios have been defined, the data values in the scenarios can be modi-
fied, as needed. To modify a scenario:

1. Click on the Data tab, click the What-If Analysis button, and then select Scenario
Manager.

. Select the desired scenario name.

. Click the Edit button.

. Modify the scenario information as desired.

1AW

. Close the Scenario Manager dialog box.

CREATING A SCENARIO SUMMARY REPORT

Included in the Scenario Manager is a feature called the Summary Report that cre-
ates a report that summarizes the result cells that are affected by a scenario. The
Summary Report appears in the form of a summary table that is placed on a new
worksheet, which can be printed.



To create a Scenario Summary Report:

. Click on the Data tab, click the What-If Analysis button, and then select Scenario
Manager.

2. Click the Summary ... button. The Scenario Summary dialog box appears.

3. Choose Scenario summary in the Report type group box.
4. In the Result cells: box, type in D7,D12,D15,D16,D17. Result cells are the cells

affected by the specified scenario.

5. Choose OK.

6. Excel produces a Scenario Summary Report like Figure T4.17.

All three constraints you FIGURE
defined are represented here. Scenario Summary Report
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* PLUG-IN SUMMARY

* MAKING BUSINESS DECISIONS

echnology can and does play a vitally important role in both supporting decision mak-ing
and, in some instances, actually making decisions or recommendations. Microsoft Excel

2013 spreadsheet software has an integrated set of tools combining the analyti-

cal methods that can be applied to different problems. The If function, Goal Seek, Solver, and
Scenario Manager analysis tools have the capability to identify patterns, trends, and rules and

create “what-if” analyses.

1. Spotlight Video Rentals

Spotlight Video is a premier video rental company in Denver, Colorado, offering the latest
selections on DVD, game, and VHS releases. After DVDs and VHS tapes have been viewed
a certain number of times, their quality deteriorates to the point that Spotlight Video con-
siders them to be defective. Furthermore, some customers own DVD and VHS players that
are defective and can ruin Spotlight Video’s merchandise.

Spotlight Video wants to maintain an inventory of DVDs and VHS tapes that are at least
85 percent acceptable, although 95 percentis preferable. However, since it cant keep cus-
tomers’ machines from damaging the rentals, Spotlight Video has had to relax its criterion
a little. You have been hired to create a spreadsheet that will evaluate each DVD and VHS
based on the following criteria:

= Number of times each title has been rented.
m Number of defects that have been reported.
m The percent acceptable must be above 85 percent based on usage. If the percent-

age reported is below 85 percent, then Spotlight Video wants to flag this video as
“REPLACE.”

Spotlight Video has provided you with the data in a file called T4_SpotlightVideo_Data.
xlIs. You will want to create an IF function to write a conditional expression that examines
the criteria mentioned above. Figure T4.18 displays a sample of the output that Spotlight
Video needs.

. Scheduling Solver

AirPlains Airline is a new airline company that maintains a schedule of two daily flights
each way between Salt Lake City, Denver, and Chicago. AirPlains Airline must strategically
position itself as a low-cost provider in a volatile industry. Therefore, it must work toward
finding a minimum cost for assigning flight crews to a given flight schedule while satisfying
restrictions dictated by the Federal Aviation Administration.

Using Excel Solver, determine all the possible crew rotations based on the flight sched-
ule below. You will want to find an approximate expected cost of each combination and
then solve the original crew scheduling problem by using these costs. Second, you will
want to calculate the crew constraints to determine the decision variables, constraints,
and objectives.

T4-13
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FIGURE

i i Al B [.c [ D [ E [
SpOt“ght Video Report 7 SPOTLIGHT VIDEOC DEFECT REPORT
Sample 3
#0OF #0F

] MOVIE TITLE RENTAL | DEFECT | STATUS
4 S S
5 | 1|Walk the Line (2005) 114 ]
6 | 2|Yours, Mine and Qurs (2005) 53 5
7 | 3|The Weather Man (2005) 112 54
8 | 4|Morth Country (2005) 23 12
9 | &|Daomine (2005) 100 12
10 | 6|Saw Il (2005) 44 19
11| 7[Rent (2005) 53 12
12| 8[Just Like Heaven (2005) 42 26
13 | 9|Elizabethtown [2005) 92 26
14 | 10|Zathura: A Space Adventure (2005) 20 19|REPLACE
15 | 11|Flightplan (2005) 44 40(REPLACE
16 | 12|Waiting... (2005/1) 88 26
17 | 13[In Her Shoes (2005) H 33|REPLACE
18 | 14|Corpse Bride (2005) 99 33
19 | 15|The Legend of Zorro (2005) 62 33
20 | 16|Proof (2005) 24 19
21 17[Lord of War {2005) 50 47|REPLACE
22 | 18|The lce Harvest (2005} 9 5
23 [ 19|Pride & Prejudice {2005} 34 5
24 | 20|Transporter 2 (2005} 74 54
25 21|Red Eye {2005/} 55 54|REPLACE
26 |22|Wallace & Gromit in The Curse of the Were-Rg 29 26|REPLACE
27 | 23|Doom (2005) 78 26
28 | 24[Wedding Crashers (2005) 66 61|REPLACE
29 | 25[The Man {2005} 51 47|REPLACE

The AirPlains Airline flight schedule is as follows:

(From To Departure Arrival N
Salt Lake City Denver 9:00AM 12:00Pm
Salt Lake City Denver 2:00pPm 5:00Pm
Salt Lake City Chicago 10:00am 2:00pPm
Salt Lake City Chicago 3:00pm 7:00Pm
Denver Salt Lake City 8:00AMm 11:00Am
Denver Salt Lake City 2:00Pm 5:00Pm
Denver Chicago 9:00aMm 11:00Am
Denver Chicago 3:00pPm 5:00pPm
Chicago Salt Lake City 8:00Am 12:00pm
Chicago Salt Lake City 2:00Pm 6:00Pm
Chicago Denver 10:00am 12:00Pm

Ghicago Denver 4:00Pm 6:00Pm J
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Apply the following business rules (constraints) to your model:

1. Acrew that leaves a city in the morning has to return to the same city at night.
2. The crew can return on another airplane. There are six airplanes in use.

3. When a crew is flying, the cost is $200 per hour.

4. When a crew is waiting or returning, the cost is $75 per hour.

3. DVD Sales
Hans Hultgren, the sales manager for DVD Sales, wants to maximize his profit on the sale of
portable DVD players. He already has two portable models he plans to sell:

Panasonic DVD-LS50 $349.95 $192.47

kMintek MDP-1810 $199.95 $109.99 J

Hans needs your help in calculating his maximum profit. First, he would like you to use
the Web to locate the retail price of two other portable DVD players not listed in the table
above. The wholesale price of each unit is 55 percent of the retail price for both units you
find. Hans has two constraints:

1. Hans has $200,000 to purchase new DVD players. The total wholesale cost of the four
types of DVD units must be less than $200,000.
2. Hans must purchase a minimum of 100 units of each player from his wholesaler.

You want to use Excel Solver to maximize the total profit for Hans with the constraints
mentioned above and limiting the number of units to positive integers.

4. Maximizing Profit
HotSprings Spas manufactures and sells two spa models: the Steamboat and the Classic.
HotSprings Spas receives spa bodies from another manufacturer and then adds a pump
and tubing to circulate the water. The Steamboat model demands 15.5 hours of labor and
14.5 feet of tubing. The Classic model requires 10.5 hours of labor and uses 20 feet of tubing.
Based on selling patterns, the owner, Deborah Liebson, has determined that the Steamboat
model generates a profit of $400 per unit, and each Classic model generates $345 profit.
While Deborah would like a large labor capacity and sufficient tubing and motors to build
any number of spas, her resources are limited. For the next production period, Deborah has
2,650 labor hours, 3,450 feet of tubing, and 231 pumps available. Deborah needs assistance
in figuring out how many Steamboat and Classic models to build in order to maximize her
profit. Given the constraints above, use Solver to assist Deborah in her what-if analysis.
Deborah has provided you with a screen shot of a template you can use to get started
(see Figure T4.19.
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FIGURE

HotSprings Spa
Template
. ——— o
= A B T JS S T F— = — F [ G
11| HotSprings Spas
2
3 [Assumptions [Steamboat] Classic |
L 4 | Quantity to produce
| 5 | Profit per unit ] 400 5 345
6
Bl Total Profit $
8
9 [Constraints [Steamboat] Classic |
| 10 Labor to build (hours) 15.50 10.50
| 11| Piping required (feet) 14.50 20.00
112 | Pumps required 1 1
13
14 Pool of ilable resources | Allocated [ Available |
| 15 | Labor - 2,650
| 16 | Piping - 3450
| 17 | Pumps - 231
18

5. Budget Constraints
Joanne Krol wants to purchase a newer model automobile to replace her rusty 1989 car.
The bank where Joanne has a checking account, US Bank, is advertising an annual inter-
est rate of 6.75 percent for a three-year loan on used cars. By selling her old car and using
some cash she has accumulated, Joanne has $3,000 available as a down payment. Under
her current budget, Joanne figures that the maximum monthly loan payment she can afford
is $300. She wants to find out the maximum car price she can afford and keep the monthly
payment no higher than $300. She cannot alter the interest rate or the three-year term. Use
the Excel Goal Seek command to figure out the highest purchase price Joanne can afford.
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